
Release Notes - OVIS 6.20

HP OpenView Internet Services 6.20

Release Notes                       

April, 2007 
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HP OpenView Internet Services is copyrighted and licensed by Hewlett-Packard Company. Please refer to the 
licensing agreements on the installation media. 

 
 

Announcements

●     The HP OpenView Internet Services team is pleased to bring you this newest release of OVIS. Please 
take a few minutes to review the What's New in OVIS 6.20 section below for a complete overview of 
the features included in this release.

●     If you are upgrading to OVIS 6.20 from an earlier release you can review the What's New section of 
the release notes for the interim releases such as 6.0, 6.10, 6.11. You can access these documents 
from the following URL: http://ovweb.external.hp.com/lpe/doc_serv/. 
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What's New in OVIS 6.20

IMPORTANT NOTE:  The hardware requirements are 2 GHz or more CPU, 1 GB or more memory and 
800 MB of disk space initially to support new OVIS capabilities.  

In the OVIS 6.20 release you will find the following new features and enhancements: 

QUALITY

●     All hotfixes and patches to OVIS 6.10 are included.

PROBES AND SCHEDULER 

●     New VuGen probe on Windows - for easy integration of VuGen (Virtual User Generator) scripts. 

●     Maximum Threaded Targets setting for improved HTTP and ICMP probe scalability (a Network 
Connection setting).

●     Scheduler Probe Timeout Mulitiplier setting for high scalability probe environments.

HTTP_TRANS IE MODE PROBE ENHANCEMENTS 

●     Protocol Timing feature provides more expanded view to the physical network traffic. This provides 
component download size and response times in traces, and network-based first response time.

●     excludeProxyList advanced step command to disable proxy for certain domains.

●     contentType advanced step command for posting data that needs special content type.

●     userAgent advanced step command for posting data that needs a special user agent specification.

●     hostHeader advanced step command for posting data that needs a special host header.

●     useProxy advanced step command for transaction that requires a proxy on only some of the steps.

●     Delay=<millisecond delay> advanced step command for transactions that require a delay on a specific 
step.

●     Variables for pattern matching special characters.

●     Variable pattern matching for Data/Time and locale.

●     Pattern matching against a time with a variable delta.

HTTP PROBE ENHANCEMENTS

●     Content Type field in HTTP service target dialog for posting data that needs a special content type.

PLATFORM SUPPORT

●     For probe systems, HP-UX IPF and Linux 2.6 kernel platforms are now native (not emulation)
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DOCUMENTATION UPDATES

The OVIS user documentation has been updated for the 6.20 release and is provided as .pdf files on the OVIS 
Windows CD in the Documentation directory and these files are installed with the product. The documentation 
is also available online at this URL: http://ovweb.external.hp.com/lpe/doc_serv/.

●     OVIS Users Reference Guide (IS_User_Ref_Guide.pdf)

●     OVIS Web Transaction Recorder Guide (webrecorder.pdf)

●     OVIS SQL Server and Oracle Database Configuration Guide (Reporter_Database_Config.pdf)

●     OVIS Custom Probes API Guide (CustomProbes.pdf)

●     OVIS Release Notes (IOpsReleaseNotes.pdf)

Refer to the Dashboard and TIPs overview documents in <install_dir>\help\iops\c\OVIS 60-dashboard.pdf and 
ovis60-tips.pdf to get more information about the new Dashboard and Troubleshooting Insight Packages.

OTHER CHANGES

●     Support for MS Clustering  
A document detailing the process for installation and configuration of OVIS 6.10 in a Microsoft Cluster 
was made available following the release of OVIS 6.10. Request QXCR1000291994 is updated with the 
document location information. The request QXCR1000291994 can be located at   http://www.
openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000291994

The probes directory layout changed with OVIS version 6.10. The script probe (probeScript), IE mode 
HTTP_TRANS (probeHttpTrans2) and custom probes are affected by these changes: 

●     Scripts distributed from newconfig\distrib are now placed under bin\instrumentation\probe\scripts 
(previously they were placed under \probes\scripts). The script probe switches to bin\instrumentation
\probe before executing a script. There should be no modifications necessary to the script unless the 
script relies on components that are not found under bin\instrumentation\probe\scripts or the PATH 
environment variable.

●     All OpenView delivered probes are now installed under the bin directory. Custom probes should 
continue to be installed under the probes directory in order to avoid file name clashes with OpenView 
binaries. The scheduler is able to execute probes from both directory locations. 

●     Certain custom scripts used by the IE mode HTTP_TRANS probe might not work (e.g., perl scripts) and 
the command line for the script must be adjusted. The scripts can be distributed (see above) or 
installed in the probes directory. 

 
 

Fixes in the OVIS 6.20 Release

The following items (identified by error tracking number) are fixed in the OVIS 6.20 software release. 
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Note that the number listed (e.g., QXCR1000230447) is the number used in OpenView's Software Support 
Online web site http://support.openview.hp.com/.    So for example, you can click on the QXCR listed and link 
to the URL http://openview.hp.com/sso/ecare/getsupportdoc?docid=QXCR1000389582. 

If you aren't logged in to OpenView's Software Support Online web site, you will see a log in screen first, 
otherwise you will link directly to the self-solve document. If for any reason the URL link does not work, you 
can search the OpenView Software Support Online web site for the QXCR number.

QXCR1000389582: RunAs feature defective in IS_00006 breaks custom (probe builder) probes. 
QXCR1000389820: iopscollector fails to move data into reporter database Unable to write to file.  
QXCR1000383827: Scheduler aborting processes too soon if they timeout. 
QXCR1000376805: An http probe with a time delta pattern match can core dump on linux. 
QXCR1000372241: Dynamic Substitution for PATH doesn't work on Linux. 
QXCR1000363140: Remote probe installer for Linux2.6. 
QXCR1000346145: Secure Http probes not working with new Scheduler. 
QXCR1000340602: Scheduler errors out with large queue files in ssl mode on linux. 
QXCR1000346483: Bus error occurs to Script Probe on HP-UX11.11. 
QXCR1000346496: The tail of the Dashboard" was cut off. 
QXCR1000332662: Script probe on Solaris is wrong in a judgment of Exit Status. 
QXCR1000337188: Resource leaks of Scheduler process and other process. 
QXCR1000330622: At DNS probe, the letter string won't be included when response from DNS server. 
QXCR1000331125: Need to create a !Find command for outer HTML text. 
QXCR1000313574: Can't open HTTP, HTTPS and SOAP probe configuration window. 
QXCR1000308914: HTTPTrans does not run if 'run as' account is not logged in. 
QXCR1000310089: Duplicate  entries in IOPS_DETAIL_DATA_DAILY table. 
QXCR1000386658: OVIS - Scheduler does not timeout networks when it is supposed to. 
QXCR1000399916: Impact of US EP Act 2005 on OpenView Internet Services. 
QXCR1000387868: The Concurrency  incorrect  when Probes of multiple priorities involved. 
QXCR1000386559: Uninstallation of OVIS does not uninstall the patch. 
QXCR1000387865: Allow WTR to handle form name with multiple dots for play back  in Remote Probes. 
QXCR1000377268: OVIS - dashboard - date not shown in browser system's locale format. 
QXCR1000389872: Scheduler processes piling up on linux when probe launch fails. 
QXCR1000385886: probeSMS dies when > 18 messages are in store, plus doesn't delete messages. 
QXCR1000384506: probeIcmp may never timeout on Solaris. 
QXCR1000381662: ICMP probe showing available when it shouldn't be. 
QXCR1000381499: probeIcmp aborts on solaris with unreachable host. 
QXCR1000379166: DELTA pattern matches not working when recv's span multiple buffers. 
QXCR1000379642: Apostrophe in HTTPTRANS step label not handled by OVIS Dashboard. 
QXCR1000338819: OVIS Installation to SQL Server 2005 failed. 
QXCR1000382530: WebRecorder had a problem with pattern matching with multiple patterns/settings. 
QXCR1000367957: Scheduler A.06.10.049 is unable to launch probes with high priorities. 
QXCR1000376809: dumponfailure option removes old dump when target available. 
QXCR1000375355: Allow WTR to handle form name with multiple dots for play back. 
QXCR1000368726: OVIS 6.1 Dashboard: Flaw in time filter using custom time. 
QXCR1000363386: Threaded processes should not be counted towards maxconcurrent. 
QXCR1000362888: Misleading error message when redirected http target fails. 
QXCR1000362860: UserAgent field not working in threaded mode for probeHttp. 
QXCR1000365951: WebRecorder occasionally reports a negative Setuptime. 
QXCR1000363515: OVIS 6.1 Dashboard SLA Conformance percent incorrect. 
QXCR1000355230: Target Status in Dashboard is showing available when it should show unavailable. 
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QXCR1000355231: OVIS 6.1 Dashboard availability percent incorrect. 
QXCR1000329833: I18N: cannot find Japanese 'Local System' in Configuration Manager. 
QXCR1000338561: OVIS6.11 can't set up a proxy configuration, in the "Test On Management Server". 
QXCR1000330598: I18N: Remote probe installation failed on Windows 2003 with OVPA 4.5 is installed. 
QXCR1000344073: ovtomcatA keeps dying several times a day. 
QXCR1000330626: DNS probe won't be able to resolve "hostname from IP address". 
QXCR1000338005: Tips Pregather in MeasEvent is Hanging TIPS. 
QXCR1000324790: Scheduler doesn't terminate probe threads correctly. 
QXCR1000334305: Zombie probe processes running on UNIX. 
QXCR1000332675: ODBC Probe can't do Pattern Matching in specific character string, it's "1_S". 
QXCR1000308094: SSL communication not working for Remote probes on HPUX. 
QXCR1000328812: distributed scripts disappear due to second run of Scheduler. 
QXCR1000331793: Non recurring, midnight spanning DTs come out of DT at 12:00 AM. 
QXCR1000328181: DST fix needed for 6.0. 
QXCR1000323164: Dashboard some times hangs with 2 less than or equal to 2. 
QXCR1000323511: Screen Capture TIPs HTTP_Trans Probe fails if Service Name Length greater than 40. 
QXCR1000289339: OVIS iopsconfig fails to come up after upgrade from 5.2 to 6.0. 
QXCR1000315157: probeImap / Sun coredumps with > 283 email messages on IMAP server. 
QXCR1000316705: OVIS - sort scheduled down times by description in Config Mgr. 
QXCR1000281824: Weekly DT doesnt work if it has midnight boundary b/w server & remote probe stn. 
QXCR1000308418: probeSMS aborts when tracing is set to a level higher than 4. 
QXCR1000311325: 11:00 PM - 12:00 AM DT not recognized after switch from DST to ST. 
QXCR1000300448: Web Recorder is crashing. 
QXCR1000297600: OVIS 6.0 - issues with Dashboard when using Custom Probes. 
QXCR1000294977: OVIS 6.0 - Dashboard errors with long TargetInfo strings. 
QXCR1000291880: OVIS 6.0: Custom reports do not appear in pull-down on dashboard. 

The following enhancements are included in OVIS 6.20

QXCR1000375619: ER: OVIS - allow WTR to handle form name with multiple dots (full implementation. 
QXCR1000367960: ER: OVIS - enhance tracing for Scheduler to ease debugging "Run As User" issues. 
QXCR1000282499: PostData Substitution doesnt happen properly if formdata elements have same name. 
QXCR1000346118: ER: Add support for OVIS 6.10 OVO integration package to install on IA64 system. 
QXCR1000350305: ER: WebRecorder needs to be enhanced to optionally kill Adobe AcroRd32 processes. 
QXCR1000307745: SF requests Product Certification for OVIS 6.0/6.10 Rptr on MS-SQL 2000 SP4 db. 
QXCR1000301749: OVIS 5.01 - IMAP probe does not delete mail - duplicate to QXCR1000293880. 
 

Verified Environments

Please refer to http://support.openview.hp.com/sc/support_matrices.jsp for up-to-date information on 
supported platforms.  The support matrix is also provided on the OVIS Windows CD in the Documentation 
directory.

Integration with Other hp Software Solutions
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Please refer to http://support.openview.hp.com/sc/support_matrices.jsp for up-to-date information on 
integrations with other OpenView Solutions.  The support matrix is also provided on the OVIS Windows CD in 
the Documentation directory.

Check the hp Software web site (http://www.hp.com/managementsoftware/services) for current information 
on compatibility of OVIS with new releases of other OpenView products.

Refer to the Support\Support Tools folder on the OVIS CD for a list of installed files.

OVIS 6.20 Coexistence with other OpenView Components

Multiple OpenView Products and Tomcat Port Conflicts 

OVPM 5.0, NNM 7.5, SIP 3.X and OVIS 6.20 use a common version of the Tomcat applet server and the same 
default ports (8005 and 8088). Release notes for each product discuss how to change the port setting to avoid 
conflicts. OVIS checks for ports currently in use at the time it installs, and will prompt for different ports if it 
finds the defaults are in use.

Port Conflicts with other OpenView Products and Applications Using Tomcat

If you find there are port conflicts with OVIS and other OpenView products when installed on the same 
system, you can change the OVIS Dashboard ports (Tomcat) on the OVIS Management Server. See the 
example below (the port numbers shown below are just examples):

cd <install dir>\bin 
ovc -stop ovtomcatA 
cscript /nologo ovtomcatCtl.vbs -setshutdownport 9005 
cscript /nologo ovtomcatCtl.vbs -sethttpport 9080 
cscript /nologo ovtomcatCtl.vbs -setjk2port 9007 
ovc -start ovtomcatA 

You can use netstat -an to see which ports are taken. You could also use the following command to check if a 
port is in use: cscript/nologo ovtomcatctl.vbs -checkport 9005.

Note, after changing the ports, you need to also configure the http port that you chose above in the OVIS 
Configuration Manager File > Configure > Web Server Properties dialog. Enter the port number in the Tomcat 
- Dashboard (Web Server) Port field.

Before You Install

Before you install you should read the section for All Users below.  In addition, there are different 
considerations for updates to existing OVIS installations covered in the section for Update Users. These are 
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referred to as New and Update (below). See the Security Alert section that follows. Also check the support 
matrix http://support.openview.hp.com/sc/support_matrices.jsp. The support matrix is also provided on the 
OVIS Windows CD in the Documentation directory. 

All Users

1.  Check the "Installation Prerequisites" section in Chapter 2 of the OVIS User's Reference Guide to make 
sure you have the required hardware and software for both the management server and probe 
systems.  UPDATE users need to check this since minimum requirements and supported platforms and 
operating system versions will change over time.

2.  Before you install on Windows 2003 systems, please refer to http://support.openview.hp.com/
selfsolve/do/search and type in "OV-EN019294 for IIS configuration and coexistence issues before you 
install the product" or similar text.

3.  Windows Server 2003 WARNING: By default Windows Server 2003 systems have Internet Explorer 
Enhanced Security enabled with very restrictive access.  You must change the configuration to prevent 
all basic OVIS communication functions from failing with various HTTP errors.  See problem 
QXCR1000050345 in the “Known Problems” section “Communications” subsection for Workaround 
information

4.  Check the Microsoft web site for the latest service pack and hot fixes to keep your systems up to date 
with known security fixes.

5.  Check http://support.openview.hp.com/sc/support_matrices.jsp to make sure you are integrating with 
the correct versions and patch levels for other OpenView products.  UPDATE users need to check this 
since these versions may change from one OVIS release to another.

6.  Remote installations are supported on Terminal Services in Remote Administrator mode from a CD or 
local disk. OVIS cannot be installed remotely for Terminal Services in Application mode or remotely 
from mapped network drive. Remote installations are also supported over VNC.

7.  Prior to starting the upgrade, please stop all OpenView products. If your system does not coexist with 
any other OpenView products, then it is enough to simply ensure that all OVIS clients are stopped (e.
g., the OVIS and TIPs Configuration GUIs). If on the other hand the OVIS installation coexists with 
other OpenView products, you must stop those products prior to starting the upgrade (e.g., OVPM’s 
Tomcat service cannot be running during an OVIS upgrade). 

Failure to stop these processes may result in your encountering the known defect ‘QXCR1000288201’. 
Please refer to the defect details for complete information on both symptoms and workarounds. (In 
essence, leaving these products up results in the system keeping OVIS files busy. This in turn 
interferes with both files being placed at the proper time and TIP’s efforts to upgrade/import the latest 
Out Of the Box TIP Definitions.)

8.  Before you Update, disable any agents which automatically start OVIS services, for example, the BMC 
Patrol Agent or the NetIQ Agent.

9.  With OVIS 6.x we now enforce both Standard target licenses and Custom Target licenses. Customer 
using probes created with either OVIS Probe Builder or OVIS Custom Probe SDK must ensure proper 
license keys are installed.

10.  If custom probes were configured in a previous release of OVIS without the correct custom probe 
license, the custom probes will be deactivated (see QXCR1000229952). In order to activate the 60 day 
trial for the custom probes, open up the Configuration Manager and select File > Save Probe 
Configuration or select the Save icon. 

11.  A number of server ports are now used with OVIS 6.x. During installation, the following default ports 
are used in the Tomcat Servlet Container Configuration:
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8080 (HTTP - OVIS Dashboard) 
8009 (JK2 - AJP communication via Apache) 
8005 (Shutdown)

If any of these ports are already taken, the installation program will prompt you to select a different 
port. In addition you may change the ports and other ports used by OVIS, later, after installation. See 
the OVIS User's Reference Guide for more information.

12.  Korn shell (ksh) is required for the UNIX remote probe software installation scripts.

13.  Choosing 'Operations for Windows Integration' install from the OVIS Windows CD install menu might 
give the error The Msiexec.exe application could not be located. Please insert the next disk and press 
OK to continue. 
Workaround: The cause of the problem is that install is being run in Terminal Services EXECUTE 
mode. Use Add/Remove programs in the Control Panel, select Add New Programs. Select the CD or 
Floppy button, select Next on the Install Program from Floppy Disk or CD-ROM dialog, select RunSetup.
cmd and select the Finish button to launch the Install Internet Service menu.  
You may also change the run mode for the server to INSTALL by using 'change user /INSTALL' 
command from a command prompt so that the Terminal Server run mode is switched during the install 
of OVIS. If you change the user command to switch the run mode, please remember to run the run 
mode back to EXECUTE after the installation with the command 'change user /EXECUTE'. You can use 
the command 'change user /QUERY' to determine the current run mode.

14.  After upgrading, if the DNS server resolves a probe location name to something other than how it was 
configured in the Configuration Manager, you will see both systems listed in the Dashboard as probe 
locations until the old data has rolled out of the time filter. For example, if your time filter in  the 
Dashboard is set to 4 hours, you will see two systems listed as probe locations until the 4 hours after 
you upgrade. If you delete a probe location from the configuration manager and then add it back you 
will see this same behavior.

15.  If you are creating custom reports for standard probes the report name must now be prefixed by 
'IOPS_' plus the probe type name. For example, if you are adding a report for HTTP probe, the report 
name must be in the form 'IOPS_HTTP_MyNewReport'. 

PROBENAME: HTTP 
DESCRIPTION: HTTP - Web Pages  
PROBEMETRICLIST: IOPS_HTTP  
...  
END_PROBENAME: 

REPORT: IOPS_HTTP_MyNewReport  
CATEGORY: 190 Internet Services  
ALL_TEMPLATE: reports\IOps\a_IOps_Http.rpt  
HTML_DIRECTORY: webpages\a_iops_http  
DESCRIPTION: HTTP - Web Pages  
MAXTIME: 10  
FAMILY: "Internet Services"  
END_REPORT: 

GROUPREPORT: IOPS_HTTP_MyNewReport  
GROUP: ALL  
END_GROUPREPORT:

If you are creating custom reports for custom probes then the report name must be equal to 
the custom probe name prefixed by IOPS_ (see the Custom Probe API Guide for more 
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information).

16.  With the remote probe Windows silent install there is a new TIPS_PORT variable.

17.  Note that a reboot is required after installation on the server.

Updating Crystal Report Templates:

The templates of Crystal 8.5 (or earlier version), when used with Reporter 3.6, (which uses Crystal 10 
binaries) may break the HTML files created by the ‘Repcrys’ module. You may have to change the 8.5 
templates based on the issues encountered. Please note that all the out-of-the-box Crystal Reports templates 
that accompany Reporter 3.6 Full are properly converted and should work fine without any issues. 

Note: Crystal 10 has backward compatibility problems with earlier Crystal versions. The modified templates for 
OVOW, and SPIs are available at ftp.hp.com/pub/ovreporter. You can download the readmefirst.txt file to 
check for updates. 

The following changes are applicable for users who wish to use their customized Crystal 8.5 templates with 
Reporter 3.6 and OVIS 6.x. 

All the reports can be edited with Crystal Reports 8.5 with the following modifications in order to be able to 
support Crystal 8.5 and Crystal 10 from the same templates. If it is required to support text fields longer than 
254 characters (or 127 Japanese characters), the reports must be edited using Crystal 10 as there is no way 
to do this with Crystal Reports 8.5. 

●     Problem: Crystal 10 does not truncate fields based on the field length defined in the report template. 
So in the exported HTML files, if the data in the database is longer than the field length defined in the 
report template, the data will overlap with the neighboring field.  
Solution: Modify the templates to validate all of the fields to make sure the field defined in the report 
template is at least the same size as the field in the Reporter database. It might not be always 
possible to have the full length of the database fields displayed, as e.g. object or application fields with 
254 characters would not leave any further space in the same line to display further information. If 
possible, the according field should be configured with the "Can Grow" option, so that the field 
automatically extends vertically. If this compromises the report design, it is possible to set the "Can 
Grow" option with a maximum number of lines =1. In this case, Crystal Reports10 truncates data 
again, but only for formula fields and with a different mechanism. So plain database field objects must 
be placed into a formula and it must be checked if the new truncation mechanism does not truncate 
important information.  
Sometimes the problem of overlapping can not be solved only using the "Can Grow" option (for 
example, if there is a field with a big font size, it can overlap underlying fields despite this option). In 
this case the problem field can be placed into a separate report section.

●     Problem: Exported HTML reports will not have space in the LHS (left hand side).  
Solution: Modify templates for LHS space manually by setting the margin for the report. Adding an 
additional 1/4 inch margin should solve the problem. 

●     Problem: The Hyperlink used to display banners is not parsed and hence becomes visible text. The 
‘less-than’ and ‘greater-than’ symbols are translated to character entities, which prevent the text from 
being recognized as HTML.  
Solution: The solution is to use OLE object linking to get some minimal of linking of banners working 
with Crystal Reports 8.5 and Crystal Reports 10. Instead of embedding the banner in the report, you 
have to insert an OLE Link to the banner graphic in the report. This requires to have a fixed location 
and size in the banner files and customers can only exchange with banners of an equal size. Also, If 
customers want to include their own banners in the reports, they will need to purchase Crystal Reports 
10 and modify the reports to include their banners. As they include the banner, they can size the 
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banner properly inside the report. 

●     Problem: Boolean or single bit flag fields in the database (such as the SYSTEMS table’s EXCLUDE 
column) might not migrate correctly to Crystal Reports 10. The template seems to expect a numeric 
value in a selection formula that should evaluate to a Boolean.  
Solution: Bit flags cannot be used with Crystal Reports10 and Oracle. Oracle knows only the numeric 
data type and accordingly Crystal Reports10's data type checking will cause an error if true/false 
checks are used. Therefore such fields must be implemented as Integer across all databases and the 
reports should use "field=0" checking. Using " =0" will work for both Oracle (numeric field) and SQL 
Server (bit field). 

●     Problem: Crystal Queries are no longer supported with Crystal Reports10.  
Solution: The reports have to be changed to work without queries. If this is not possible (example, if 
a UNION must be used without any other leading table) you might be forced to create views in the 
database to cover this functionality. 

●     Problem: Every run of Repcys binary creates a set of files with distinct GUIDs as filename and ‘.png’ 
as extension in the directories that have the generated HTML files. The user would need only the latest 
set of ‘.png’ files to view the generated HTML files.  
Solution: Schedule ‘Repmaint –clean’ so that the unwanted ‘.png’ files can be removed. It should be 
scheduled well after RepCyrs has finished generating reports. 

●     Problem: When Crystal 8.5 templates are exported (using Reporter 3.6) with 'Page Break' option set, 
the 'Navigational' links in them will be broken. This is because there is a difference in the name of .
html files that get generated when exported using Crystal 8.5 and Crystal 10.  
Solution: Reporter 3.6 uses Crystal 10 and on exporting with page break, the html files are named as 
default.html where n=1,2,3..k. [Whereas, the previous version of Reporter, which uses Crystal 8.5, 
the generated html files used be named as default.htm and default.htm where n=1,2,3...k] Hence 
Crystal Reports 10 designer needs to be used to make the appropriate changes to the links in the 
report template. 

●     Problem: Formulas with the global variables and running total fields cannot be used in charts, maps. 
or cross-tabs.  
Solution: In Crystal 10, this is no longer possible. To solve this problem the report needs to be 
redesigned to work without the use of global variables in charts. 

●     Problem: Crystal Reports10 aligns but does not correctly align fields with borders.  
Solution: Remove the border from the field formatting and place an empty field with border on top of 
the value field.  

●     Problem: Crystal Report 10 cuts the blank spaces or adds empty sections at the bottom of the  
report.  
Solution: If the last line of the exported report is not completely visible in Internet Explorer, insert a 
blank text field in the report footer section. Crystal Reports10 will export the blank section at the end 
of the report according to the height of the inserted text field.  
 

Update Users

1.  When upgrading an existing OVIS Management Server, DO NOT uninstall he pre-existing version 
before installing the newer version.  This can cause the loss of critical settings and data. You should 
instead install the newer intended version  over the previous version.  
See Step 9 Updating the NNM Integration Component and Step 10 Updating the OVO Unix Integration 
Component below for important information on removing previous packages prior to updating to the 6.
x versions on the integration components.

2.  A direct upgrade from either the 3.X, 4.X or 5.0 release to OVIS 6.20 is NOT supported (OVIS 5.20 is 
the oldest upgrade supported). If you are using OVIS 3.X or 4.X or 5.0, contact your OpenView Sales 
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Representative or reseller for assistance in converting your licenses to the proper structure and to the 
new license technology implemented starting in OVIS 4.5.

3.  Before installing, remove any OVIS patches listed in Add/Remove programs.  If this is not done before 
installing OVIS 6.x, patches may be removed later without impacting the current install.

4.  Update both the management server and the remote probe system software at the same time to keep 
data and configuration synchronized.

5.  Do not shut down or unlink the database during installation since table modifications and probe 
additions are done during this process.

6.  For Oracle database users, it is recommended that you consult with your DBA before installation on the 
following issues:

●     Make sure there is sufficient free space in the table spaces that hold rollback segments, 
the Reporter database, and indexes.  Depending on the amount of data in the tables, 
extra capacity may have to be added to the indexes, table space and the roll back 
segments. Changes in OVIS 6.10 have the potential to increase sizing by as much as 
30%. The installation will fail if the required database updates do not complete. 

7.  If the logon account for the "HP Internet Services" service was changed from the Local System account 
to a user account, the logon account will be changed back to the "Local System" account during the 
software installation.   
After the upgrade is complete, you may reset the logon account to the previous setting via the Start > 
Settings > Control Panel > Administrative Tools > Services selection. Right-click "HP Internet 
Services" in the list of services and select Properties. Then select the Log On tab and check "This 
account" and browse to select the desired logon user account.

8.  For Remote Probes: After you have installed or updated the software on all remote probe systems, you 
must "Save Configuration" in the OVIS Configuration Manager in order to collect data on those remote 
probe systems. Note: installing OVIS server on top of remote probes is not supported.

9.  If you are using NNM Integration, you should first remove the existing integration components and 
then update to the new version of OVIS integration software on the NNM Console.  This will update the 
integration in general. 

10.  If you use OVO UNIX integration, prior to upgrading to the OVIS 6.120 OVO UNIX integration 
component, be sure to remove all previous templates and associated template groups. Also note that 
the OVO/U integration has to be updated on the OVO Server. See "Integration with OpenView 
Operations for Unix" section in the User's Reference Guide for more information.  

11.  Note that there is a new tracing utility for the new Dashboard and TIPs functions.

12.  Please refer to the Known Problems and Workarounds section of these Release Notes for additional 
information that may pertain to your installation. 

13.  Please refer to the Installation Notes section of these release notes for information on checking to 
determine if the HP-supplied TIPs automatically upgraded and how to do a manual HP-supplied TIPs 
upgrade.

14.  Please refer to the Installation Notes section of these release notes for information on manual 
procedures for upgrading user created TIPs online help files.

Security Alert  

ORPHANED “OVOPS” INSTANCE: When you switch from the default "OVOPS" instance of the Reporter 
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database to either Oracle or MS SQL Server 2000, the normal procedure leaves the default “OVOPS” instance 
in place.  This allows the flexibility of switching the database back to that instance via a simple ODBC 
configuration if needed.  This instance, though not in use by OVIS, may be vulnerable to the “Slammer” worm 
or other viruses. To eliminate this vulnerability:

Delete the instance.  This is the preferable option if you know the instance is not in use by OVIS or another 
product such as Reporter or Operations for Windows (OVO).  It also prevents future vulnerabilities this 
instance may have.  The procedure for this is to:

1.  Copy the repair.vbs file from the OVIS media CD under \Support\Support Tools to a local 

empty folder on the system. 

2.  Open a command prompt to the location where the file was copied and enter the following command 
line: 
cscript repair.vbs -remove //T:999 

3.  This starts up a menu where you can select/un-select components for removal.

4.  Click the Un-select all button and then select only the "Microsoft SQL Server Desktop Engine" 
checkbox.

5.  Click the Remove Components button and wait for the uninstall to complete.

6.  Click the Exit button to terminate the script.

WARNING: If the Delete Instance procedure above does not successfully complete for any 
reason, there is an additional procedure on the CD in the Support\Support Tools directory.  
This procedure should only be used as a last resort.  It is recommended to contact a support 
representative before using it.

If you have chosen to switch from the default MSDE 2000 database to SQL 2000, it is your responsibility to 
check that the Microsoft SQL Server 2000  Service Pack version is updated for the appropriate security level.  

Installation Notes

Installation Instructions

IMPORTANT NOTE:  There are increased hardware requirements (2 GHz or more CPU, 1 GB or more 
memory and 800 MB of disk space initially) to support new OVIS capabilities.  

Installation requirements (hardware and software requirements), as well as instructions for installing OVIS 
server software, remote probe software and integration components, are documented in the OVIS User's 
Reference Guide provided in Adobe Acrobat (.pdf) format. The document file is included on the OVIS Windows 
CD media as: 

Documentation\IS_User_Ref_Guide.pdf 

After installation the document can be found at: 
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<install dir>\help\iops\c\IS_User_Ref_Guide.pdf 

Please refer to http://support.openview.hp.com/sc/support_matrices.jsp for up-to-date information on 
supported platforms and integrations with other OpenView products.  

Configuring TIPs After Installation 

●     The TIPs Server uses two default ports: 

❍     Port 8080 is the default port to communicate with TIPs Viewers (this is the default Tomcat 
HTTP port used by OVIS). 

❍     Port 6604 is the default port to communicate with TIPs Runners 

These port numbers must be available for incoming communication on the TIPs Server system. If you 
use a firewall, both of these ports must be open for communication. 

The default communication with TIPs Runners is standard HTTP protocol. TIPs communication is more 
secure when you use SSL certificate based communication. Refer to the TIPs online help, from within 
the TIPs Configuration program, to understand how to re-configure the TIPs Server ports and 
communication protocol, if necessary.  To enable secure communications between the TIPs Runner and 
TIPs Server in a firewall environment, enable port 383 on both the TIPs Server and TIPs Runner 
systems. This port is required for certificate communications.

●     Use the TIPs Configuration program to verify that the TIPs Runners have been properly installed and 
registered. From the TIPs Runners folder in the scope pane, you will see a list of all registered TIP 
Runners. If no TIPs Runners are listed, refer to the TIPs online help to troubleshoot TIPs Runners 
registration. 

●     Before TIPs can be launched, OVIS must be configured with one or more service targets. Once the 
service targets are available, TIPs can be launched from a service target in the OVIS Dashboard. If one 
or more OVIS service level objectives are configured, TIPs can be launched from OVIS alarms as well.

●     TIPs Upgrade instructions for 6.10 to 6.20 Upgrade Customers:

The out of the box TIPs configuration for OVIS will not be changed during the upgrade. To incorporate 
TIPs changes for the new VuGen probe type, TIPs definitions for OVIS 6.20 need to be imported. Use 
the following process to import the revised TIPs definitions. NOTE: This process will overwrite originally 
supplied HP TIPs definitions. If you had made modifications to HP supplied TIPs, these modifications 
will be overwritten using this process.

To import the 6.20 HP-supplied TIPs:

❍     Start the TIPs configuration program (Start->Programs->HP OpenView-TIPs->TIPs 
Configuration).

❍     As a backup, export your current configuration to a file by executing 'File->Export'.

❍     Execute 'File->Import'.

❍     Browse to <data_dir>\conf\tips\config and select the file OvTIPsOvisConfig.xml to be imported.

❍     Click the 'Override' check box.
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❍     Click the 'Import' button.

When this process is complete, the TIPs definitions supplied with OVIS 6.20 which support the new 
VueGen probe type will be imported.

●     TIPs Upgrade instructions for 6.0 to 6.20 Upgrade Customers: 

How to determine if the HP-supplied TIPs automatically upgraded and how to do a manual HP-supplied 
TIPs upgrade:

Some of the HP-supplied TIPs in OVIS 6.0 had defect fixes in subsequent releases. If you installed 
OVIS 6.20 on top of OVIS 6.0, it is possible that the repaired HP-supplied TIPs did not get installed. 
This will happen if you made changes to the 6.0 HP-supplied TIP configurations. 

To determine if the 6.20 HP-supplied TIPs were installed during the upgrade, examine the file 
<data_dir>\log\OvTIPsOvisConfigDiff.log. If the file contains the text "No differences found", you had 
made no changes to the 6.0 HP-supplied TIPs, and the 6.20 HP-supplied TIPs were installed. 
Otherwise, the 6.20 HP-supplied TIPs were not installed, and the file describes the changes you made 
to the 6.0 HP-supplied TIPs. 

If you made changes to the HP-supplied 6.0 TIPs and would still like to load the 6.20 HP-supplied TIPs, 
you can either: 

- Import the 6.20 TIPs with override on, potentially overwriting the changes you made. 

or 

- Import the 6.20 TIPs with override on, and then re-apply your changes where appropriate, using 
<data_dir>\log\OvTIPsOvisConfigDiff.log as a guide. 

To import the 6.20 HP-supplied TIPs:

❍     Start the TIPs configuration program (Start->Programs->HP OpenView->TIPs->TIPs 
Configuration).

❍     As a backup, export your current configuration to a file by executing 'File->Export'.

❍     Execute 'File->Import'.

❍     Browse to <data_dir>\conf\tips\config and select the file OvTIPsOvisConfig.xml to be imported.

❍     Click the 'Override' check box.

❍     Click the 'Import' button. 

If you re-apply your changes after manually importing the 6.20 HP-supplied TIPs, you can use the 
OvTIPsConfigAnalyzer tool, new with OVIS 6.20, to check the results of your changes. For example, to 
compare the current TIPs configuration (that which is stored in the configuration database) with the 
OVIS 6.20 HP-supplied TIPs, execute the following command from a DOS prompt: 

cd <install_dir>\contrib 
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OvTIPsConfigAnalyzer.bat -compare <data_dir>\conf\tips\config\OvTIPsOvisConfig.xml -reportFile c:
\temp\diff_6.20.txt 

The above command will create a report in c:\temp\diff_6.20.txt describing any changes you’ve made 
to the 6.20 HP-supplied TIPs. 

To compare the current TIPs configuration with the OVIS 6.0 HP-supplied TIPs, simply specify the TIPs 
2.00 configuration file as the comparison file (OVIS 6.0 used version 2.00 of TIPs, OVIS 6.20 uses a 
later version):  

cd <install_dir>\contrib 

OvTIPsConfigAnalyzer.bat -compare <data_dir>\conf\tips\config\OvTIPsOvisConfig_2.00.xml -
reportFile c:\temp\diff_6.0.txt 

NOTE: Only the configuration items in the specified configuration file are compared. Any additional 
items in the current configuration DB, for instance customer-created TIPs, are ignored for comparison 
purposes. 

●     During an OVIS 6.0 or 6.10 to 6.20 upgrade, any TIPs online help files that you created for your TIPs 
in OVIS 6.0 or 6.10 are backed up to the following location: 

<data_dir>/datafiles/tips/upgrade_backup/webapps/OvTIPsHelp.

The new TIPs online help is delivered to the following run-time location: 

<install_dir>/www/webapps/OvTIPsHelp 

After the upgrade, you must manually copy your TIPs online help files from the backup location to the 
run-time location. NOTE: Don’t copy the entire OvTIPsHelp backup directory into the run-time location. 
If you do, you will over write the new TIPs online help documentation with the previous TIPs online 
help version. 

Refer to the Creating Help Topics for Your TIPs section in the TIPs online help to review the steps to 
establish your own TIPs online help.

Using LogStat.vbs.

Synopsis:

The LogStat.vbs script, which is located on the OVIS Windows CD in the Support\Support Tools 

directory or disk area (and is also installed into the <install dir>\bin directory), can be used in 

situations where there are problems with OVIS software and you need to bundle up the status files and other 
system information for support personnel. 

This script creates a file called logstat.CAB in the [DATADIR]\HPOVInstall folder whose size will be 

on the order of ten megabytes. Note that logstat compresses all the files into the CAB file. 

Required software:
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This script is written in vbscript and requires the following: 

●     Windows Scripting Components (cscript 5.6 or higher)

●     Internet Explorer 6.0 or higher

●     Windows Installer Service, to execute correctly

Command Line usage:

Use wscript or cscript to execute the script. Double clicking on the file will run it as well, with the default 
options.  From a command line prompt window you can execute LogStat.vbs as follows:   

c:>cscript LogStat.vbs <options> 

Using repair.vbs.

Synopsis:

The repair.vbs script, which is located on the OVIS Windows CD in the Support\Support Tools directory or 
disk area, can be used in situations where the installation has failed to uninstall or special cases where you 
would like to uninstall specific components. This script can also be used to restore files that may have been 
deleted through system or user intervention on the server. The script only operates after a properly installed 
product is present on the system so the script cannot be used as a primary means of installation. The script 
will use the existing windows installer components to determine which components can be repaired or 
removed via the script. The script will also create a log in the [DATADIR]\HPOVInstall folder that can also be 
collected by logstat.vbs. 

The repair.vbs script will require the original OVIS Windows CD when attempting to run a repair. This is 
mainly because un-versioned files must always be re-installed from the source media during a repair action. If 
the source media or original install software is not available the installer will prompt you for the location of the 
msi file that is currently being installed. You can then use the browse button to locate the folder SETUP on the 
install source media, then further locate the folder containing the requested msi file. 

The repair.vbs script needs to be copied from the OVIS Windows CD Support\Support Tools directory and 
placed on the hard drive because it will create a data file that is used for determining the packages that need 
to be repaired on the system. Leaving the source media in the cd-rom or in the default network share that it 
was installed from, prevents the installation from prompting for the source media.

Required software:

This script is written in vbscript and requires Windows Scripting Components, Internet Explorer 5.0 or better, 
and Windows Installer Service to execute correctly.

Command Line usage:

Use wscript or cscript to execute the script. Double clicking on the file will run repair.vbs with default 
command line options. 
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From a command line prompt window you can execute repair.vbs as follows: c:>cscript repair.vbs 
<options>

Options:

-checkbox when set enables the checkbox dialog selection. Checkbox selection is on by default.

-noreboot when set disables the reboot dialog check. Reboot is enabled by default if there are pending 
deletes before or after script execution.

-runrepair run a repair on all products found. Automatic execution of repair is disabled by default.

-remove enables the remove option from the GUI. Remove option is disabled by default.

-? -help -HELP displays help message for options.

Most common usage:    c:\> cscript.exe repair.vbs -remove

 

Known Problems, Limitations, and Workarounds

The following areas of Internet Services are either incomplete or known to not function as expected in this 
release. This section is intended as a reference document to document known problems and their status.

Note that the number listed (e.g., QXCR1000230447) is the number used in OpenView's Software Support 
Online web site http://support.openview.hp.com/.    A URL to the self-solve document for the QXCR is also 
listed for each. If you aren't logged in to OpenView's Software Support Online web site, you will see a log in 
screen first, otherwise you will link directly to the self-solve document. If for any reason the URL link does not 
work, you can search the OpenView Software Support Online web site for the QXCR number.

For ease of reference the known problems listed below have been subdivided into the following sections:

●     Communications 

●     Install/Uninstall  

●     Probes 

●     Reports 

●     TIPs Server 

●     TIPs Runner 

●     NNM Integration 

●     Japanese Systems 
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Communications:

QXCR1000050345: Alarm engine fails to start on Windows Server 2003 running terminal services  
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000050345 
Workaround: Internet Explorer Enhanced Security is a new feature from Microsoft to control the web sites 
your users can browse on your system. When enabled (which is the default for Windows Server 2003 
installations) this prevents users from browsing untrusted websites. This will also cause warnings of 
potentially malicious software if you try to install OVIS software from a share. You also see this when browsing 
on the local system with Internet Explorer. You can work around this problem in either of the following two 
ways:

1.  Disabling "Internet Explorer Enhanced Security Configuration". This will work for local logins, but will 
not work for users running the OVIS configuration manager over a Terminal Server session. 

From the Control Panel, select Add/Remove Programs and then select Add/Remove Windows 
Component from the left-hand pane. From the Windows Components Wizard dialog, deselect 
Internet Explorer Enhanced Security Configuration, select the Next button, and then 
select the Finish button to Complete the Windows Component Wizard. Then restart IIS Admin 
Service. 

2.  Adding the sites required by OVIS to your Internet Properties Local intranet or Trusted Sites 
configuration. This will work for both local and Terminal Server logins.

From the Control Panel, select Internet Options and then select the Security tab. You are 
going to add sites to either your Local intranet or Trusted sites zone, depending on which is 
appropriate for your desired level of security. Select the appropriate zone and then select the 
Sites button. Use the resulting dialog to add both http://<hostname> and http://<hostname>.
<domainname> where hostname is the name of the OVIS management server. You may also 
add file://<hostname> if you wish to eliminate file browser warnings and warnings when trying 
to install OVIS software from a share. Then select the OK button, and restart IIS Admin 
Service. 

More information on Internet Explorer Enhanced Security model on Windows Server 2003 can be found at URL 
http://msdn.microsoft.com/library/default.asp?url=/workshop/security/szone/overview/esc_changes.asp

 

Install/Uninstall:

QXCR1000403368:Extending fix for QXCR1000332072 
Scheduled Downtimes in OVIS behave strangely in the first 24 hours of transition from/to ST/DST. That is on-
the-day of the transition. This symptom affects only midnight spanning downtimes having recurrence. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000403368  
Resolution: 
Scheduler has been fixed to work properly (with a limitation for ST to DST change) in 24hrs of change from/to 
DST. This fix is controlled through a registry key for windows and zero byte file for UNIX and Linux platforms 
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as per the details below.

For OVIS server: 
Registry Key: SwitchDTCode 
Key Type: DWORD 
Key Path:HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\Internet Services\CurrentVersion 
Value: 1

Registry info for OVIS Remote Probe System: 
Registry Key: SwitchDTCode 
Key Type: DWORD 
Key Path: HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\Internet Services Remote 
Probes\CurrentVersion 
Value: 1

Enabling the fix (Create a zero byte file) for UNIX and Linux: 
Create a zero byte file on UNIX and Linux platforms with the following command 
"touch /var/opt/OV/tmp/probe/.SDC" 

QXCR1000240022: After uninstalling Reporter or Reporter Lite component, installing OVIS may fail. This is 
due to a defect in the Reporter uninstall which removes the registry key containing the database username. 
The OVIS install will attempt to use the default database username (openview). If the Reporter database is 
not configured to "openview" user, the install will fail to connect to the database and the install will fail. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000240022  
Workaround: 
1. Set the DBUser, DBPassword keys in the registry before running the installation to the correct values.  
2. The registry keys to set are: 
HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\The Reporter\CurrentVersion\ DBUser,  
HKEY_LOCAL_MACHINE\SOFTWARE\Hewlett-Packard\The Reporter\CurrentVersion\ DBPassword.  
 
Alternate workaround: 
1. Create temprory user with user id "openview" and Password "openview".  
2. Configure the DSN for this user profile.  
3. Install OVIS 6.0 
4. After installtion remove the "openview" user and re-configure the DSN back to the original user.  

QXCR1000284406: If there is a problem installing OVIS Internet Services service, then even after root 
cause of problem is resolved, reinstalling OVIS doesn't reinstall service. The error shows up as error number 
1920. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000284406  
Workaround: After the root problem of why the service wasn't installed correctly is resolved, manually 
remove the probes package using the repair.vbs script: 
1. Copy the repair.vbs file from the OVIS media CD under \Support\Support Tools to a local empty folder on 
the system.  
2. Open a command prompt to the location where the file was copied and enter the following command line: 
cscript repair.vbs -remove //T:999  
3. This starts up a menu where you can select/un-select components for removal.  
4. Click the Un-select all button and then select only the "hp OpenView internet services - probes " checkbox.  
5. Click the Remove Components button and wait for the uninstall to complete.  
6. Click the Exit button to terminate the script. 
After removing the probes package, re-run the full OVIS install.
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QXCR1000157648: Uninstallation of OVOW 7.2 causes OVIS data to disappear. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000157648 
Workaround: The uninstallation deletes the DSN entry to the previous database and adds a new one with a 
MicroSoft Access driver specified. Use the procedure below to remove that DSN and add the proper one back. 
Note that you should see your existing data and configuration after successfully completing this procedure. If 
the OVIS database was the default Microsoft SQL Server Desktop Engine (MSDE) database then perform the 
following steps.  (For Oracle and SQL server, please follow the database specific steps as described in the 
OVIS Database Configuration guide.)  

1.  Stop IIS and Reporter

net stop iisadmin /y net stop reporter 

2.  Launch Control Panel select Administrative Tools > Data Sources (ODBC).

a.  In the ODBC Data Source Administrator, click System DSN tab.

b.  Remove the Reporter DSN.

c.  In the System DSN tab, create a new data source by clicking on Add.

d.  In the Create New Data Source dialog select SQL Server, press Finish.

e.  In the Create a New Data Source to SQL Server dialog, fill out the following fields and then 
click Next: Name: Reporter, Description: Reporter, Server: <local hostname>\OVOPS

f.  Select "With SQL Server authentication using a login ID and password entered by the user", 
enter the following login and password and click Next: Login ID: openview, Password: 
openview 

g.  Change the default database to: Reporter

h.  Click Next.

i.  Click Finish.

j.  Click Test Data Source and verify that connection was successful.

k.  Press Okay.

3.  Run Repair.vbs (from the Support\Support Tools directory on the OVIS Windows CD)

4.  If above step doesn't force a reboot, Re-start reporter/iisadmin 

net start w3svc  
net start reporter 

Note: It may take up to 1/2 hour before new data will show up in the GUI. This is due to the fact that 
iopscollector.exe and iopsmaint.exe are scheduled to run 1/2 hour from the time repair.vbs was executed.

Optional: The OpenView Trace Server is no longer installed under the service menu. To install the service, 
simply run <install_dir>\bin\trcinst.exe 

QXCR1000050424: Install Error 1923  
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Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000198648 
Workaround: This may be caused by an open "Services" applet. Close the "Services" applet.

QXCR1000018404: Uninstalling NNM 7 when installed with OVIS, breaks OVIS Configuration Manager.   
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000018404 
Workaround: On the original OVIS CD go into \Support\SupportTools and run repair.vbs. Inside of 
repair.vbs select only hp OpenView internet services , unselect all other installed items. Then 

click Repair Components . When the repair tool completes, OVIS should be back to full functionality.

QXCR1000400215: After OVIS 6.20 is installed over OVPM patch 6.00.040, using OVPM shows "The use of 
this program is no longer authorized. Call your support team for assistance (err44)". 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000400215  
Workaround: Place the xpl.jar file from \www\webstart folder into \java and restart OVPM server.

QXCR1000400275: Installing OVIS 6.20 on a system with OVSD 5.10 installed fails with the following 
message:  
ovbbccb.exe - not found entry point 
The procedure entry point 
?IsMarkedForRemoval@SocketSet_t@OvXplNet@@QBE_NABVSocket_t@2@@Z was not found from the 
dynamic link library OvXpl.dll 
Please contact support to receive a fix when it becomes available. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000400275 

QXCR1000288201: OVIS 6.0 or 6.10 to 6.20 upgrade error dialog in TIPs integration package 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000288201 
Description: This defect is encountered during an upgrade of OVIS from version 6.0 or 6.10 to 6.20 and if 
either the TIPs Configuration GUI or coexistent OpenView products are left running on the system. When 
encountered, the following error message is displayed during the ‘TIPs Integration Package’ install phase: 

Java Virtual Machine Launcher: Could not find the main class. Program will exit.  
For example when installing onto systems with OVPM 5, when its version of Tomcat is left running this error 
will be encountered. To prevent the error, you would need to run 'ovpm stop' to stop OVPM's Tomcat prior to 
staring the OVIS installation. 

Workaround: If you experience this problem, select OK in the error dialog to continue the upgrade 
installation. When the upgrade installation is complete, you will have to manually upgrade your TIPs 
definitions. Refer to the Installation Notes section in the release notes for how to manually upgrade your TIPs 
definitions.

QXCR1000229952: 6.0/6.20 Upgrade needs CM Save to activate temporary license for Custom Probes. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000229952  
Workaround: This problem occurs after an upgrade to OVIS 6.0/6.20. If custom probes were configured in a 
previous release of OVIS without the correct custom probe license, the custom probes will be deactivated. In 
order to activate the 60 day trial for the custom probes, open up the Configuration Manager and select File > 
Save Probe Configuration or select the Save icon. 
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No QXCR: On a system where OVIS 6.X and OVO Windows 7.21 (English) are coinstalled, when OVOW is 
uninstalled, libarm32.dll is removed. This does not allow repcrys to work.  
Workaround: OVIS 6.X will need to be reinstalled for repcrys to be able to work. 

Probes:

QXCR1000049829: httptrans probe IE mode may generate Temporary Internet Files that can fill up a disk 
drive. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000049829  
Workaround: See Microsoft URL http://support.microsoft.com/?kbid=301057 for a discussion of problem, 
cause, and workaround.

Another option is to create a script probe to delete these files: Create a script that will delete the files out of 
the Temporary Internet Files folder. Then use the script probe in OVIS to run this script once a day. Give this 
probe a priority of 1 and all the other probes a priority of 2 so that when they do fire together once a day this 
script probe will run first before any of the other probes, to avoid any collisions. This script should be placed in 
the \newconfig\distrib\platform\windows directory so that it will only be distributed to windows boxes. Then 
under the probe location for that probe add all the systems where you are experiencing this problem. Here is 
an example of one script:  
attrib -s " C:\Documents and Settings\Admin\Local Settings\Temporary Internet Files"  
del /Q " C:\Documents and Settings\Admin\Local Settings\Temporary Internet Files\*.*"  
The first line in this script was required to remove the system attribute from this folder so the delete could 
take place, this could be different on your system. The /Q option for delete is so that it will not prompt before 
deleting the files. Also note this is the path to my Temporary Internet Files it could be different on your 
system. You might also have folders under this directory that you want delete so you would need to change 
this script for that as well. Also you could have file and/or folders under a different user that you want deleted, 
so again you would have to modify this script for that.  
Here is a second example of how one of our customers modified the above script to suit their environment:  
rmdir /Q /S "C:\Documents and Settings\Default User\Local Settings\Temporary Internet Files\Content.IE5\"

QXCR1000285761: Remote probes crash when trace file is larger than 1.5GB 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000285761 
Workaround: Turn off the Scheduler service, wait for the files to roll over (will happen in under 1 min) and 
restart the Scheduler service. 

Reports

QXCR1000407756: Error occurred when selecting Reports in dashboard. 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000407756 
Workaround: The report descriptions can't have quotes. Removed double quotes from the report description, 
then you will be able to select a report in the OVIS dashboard.

TIPs Server:

QXCR1000219792: Expect scripts from Unix remote probe systems can result in a timeout error message. 
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Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000219792 
Workaround: The following error message displays in the TIPs Viewer as part of an expect script result: 

Error: Timed out attempting to connect to system <hostname> 

The problem occurs when the HP OpenView Ctrl Service's environment has startup errors which impact the 
ability for TIPs expect scripts to run successfully. 

The remote probe system must be rebooted, to restart the HP OpenView Ctrl Service with a valid 
environment. To insure that the HP OpenView Ctrl Service starts correctly upon reboot, the root startup 
environment (e.g., the .profile and rc scripts) must only contain commands that will execute correctly at boot 
time. 

After rebooting the remote probe system, use the following command to insure that HP OpenView Ctrl Service 
is running. 

ovc -status 

TIPs expect script commands should no longer timeout. 

TIPs Runner

QXCR1000226804: Windows Script Probe re-execute fails. TIPs Runner needs access to the Windows 
desktop.  
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000226804 
Workaround: The Script probe re-execute may fail if the script being executed requires access to the 
desktop. The HP OpenView Ctrl Service is configured to not have access to the desktop. Hence, the script, 
when launched via the TIPs Runner, will not have the required access to the desktop. (The HP Internet 
Services service is configured to have access to the desktop, thus the script will execute successfully under 
the OVIS scheduler.) 

If a TIP Command requires access to the desktop, the HP OpenView Ctrl Service configuration on the TIPs 
Runner system needs to be modified, enabling it with desktop access. Granting HP OpenView Ctrl Service 
desktop access is done through the following steps: 

1.  On the TIPs Runner system, open the Windows Services manager. 

2.  Select the HP OpenView Ctrl Service. 

3.  Select the properties for this service. 

4.  On the LogOn tab, make sure the Local System account item is selected. 

5.  Check the Allow service to interact with desktop option. 

6.  Apply the changes. 

7.  Re-start the HP OpenView Ctrl Service to insure the change takes affect 

The Script probe re-execution command should now execute successfully for TIPs. Note there will be a shift of 
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cursor focus during probe execution with this setting enabled. Although it is recommended that probe systems 
be dedicated to that purpose, there may be occasions where a user runs a desktop application on this system. 
Please be aware that a desktop application user may be surprised by sudden loss of focus when the probes 
are running.

NNM Integration:

There are several known minor issues with the OVIS/NNM integration package, most with simple 
workarounds.  

QXCR1000291935: OVIS - NNM integration fails with Solid database errors and services do not start  
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000291935 
Problem: On a Windows system running NNM 7.5, after installing the OVIS 6.20 NNM Integration package 
you might see one or more of errors that popup listed below, following which the ovisClientd and ovisEventd 
services will not start. 
a. Cannot open object database: cannot connect to database 
The ovwdb dameon is not running on the server or the port number for the ovwdb daemon has been changed. 
Ask the administrator of this server to run "ovstart ovwdb" and verify the port configuration. 
b. SsBOpen failed, file 'solid.db', error = 32, retries = 0 
c. Solid Database Engine process executed an automatic shutdown. 
Opening the database file failed. 
Probably another SOLID process is already running in the same directory. 
Date: 
Product: SOLID Embedded Engine 
Version: 04.10.0145 
Operating system: Windows NT 5.2 ix86 MT 
Workaround:  
1. Stop all services using ovstop -c. This could take a few minutes, please wait until this command finishes 
and returns to the command prompt. 
2. Uninstall uninstall OVIS NNM integration by using Add / Remove programs or using the Uninstall NNM 
integration program menu shortcut.  
3. Reboot the machine. 
4. Once the machine restarts, do yet another ovstop -c 
5. Kill any stray ovdbrun.exe processes if you see them running using Task Manager.  
6. Now reinstall the OVIS NNM integration.  
7. Verify ovisEventd and ovisClientd are both shown to be running by using ovstatus -c

Japanese Systems:

QXCR1000396064: I18N: /var/opt/OV/log/probe/error.log contains garbage on Japanese RHEL 4.0 
Software Support Online Link: http://www.openview.hp.com/sso/ecare/getsupportdoc?
docid=QXCR1000396064 
Problem:When the customer name and service group name contain Japanese characters then the logs (error 
and trace) coming from the probes shows garbage in place of the Japanese characters however all the logs 
printed from Scheduler are having proper characters. This happens in both Error.log and Trace.log files on 
Japanese RHEL 4.0 & Solaris. However HP UNIX works fine. 
Resolution:Do the following to set locale to ja_JP.SJIS (see steps for RedHat systems below): 
Add the following to .profile for the root user (or su): 
export LANG=ja_JP.SJIS 
export LC_ALL=ja_JP.SJIS 
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This would set the encoding to SJIS.

To configure Red Hat Linux system to use the ja_JP.SJIS for Japanese locale:

First, create a character map of the locale using the following command: 
# localedef -f SHIFT_JIS -i ja_JP ja_JP.SJIS 
character map `SHIFT_JIS'' is not ASCII compatible, locale not ISO 
compliant

A warning message will be displayed due to non-ASCII compatability.  
The /usr/lib/locale/ja_JP.shiftjis will be created regardless of the warning message. 

Execute the following command to create the SJIS enviroment.  
# LANG=ja_JP.SJIS

Modify the following file to add ja_JP.SJIS so that the ja_JP.SJIS env will be reflected after re-boot: 
# vi /etc/sysconfig/i18n 
LANG="ja_JP.eucJP" 
SUPPORTED="en_US.UTF-8:en_US:en:ja_JP.eucJP:ja_JP:ja:ja_JP.SJIS:ja" 
SYSFONT="lat0-sun16" 
SYSFONTACM="8859-15"

This procedure for RedHat is found at: http://kbase.redhat.com/faq/FAQ_80_1256.shtm 

 

Local Language Support

OVIS is available in English and Japanese languages.  Please check with your Sales Representative or HP 
Partner for availability of the OVIS Japanese release.

To activate the measurement server and manage Internet Services, you need to purchase a Base license 
(LTU), product number, which includes your first five (5) standard targets.  If you require more than five 
targets, you can purchase one or more add-on packs. Licensing is enforced on the total licensed capacity for 
OVIS probes and total licensed capacity for custom probes.

 

Support

Please visit the HP OpenView support web site at: 

http://www.hp.com/managementsoftware/services 
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This web site provides contact information and details about the products, services, and support that HP 
OpenView offers. 

HP OpenView online software support provides customer self-solve capabilities. It provides a fast and efficient 
way to access interactive technical support tools needed to manage your business. As a valuable support 
customer, you can benefit by being able to: 

●     Search for knowledge documents of interest 

●     Submit and track progress on support cases 

●     Submit enhancement requests online 

●     Download software patches 

●     Manage a support contract 

●     Look up HP support contacts 

●     Review information about available services 

●     Enter discussions with other software customers 

●     Research and register for software training 

NOTE: Most of the support areas require that you register as an HP Passport user and sign in. Many also 
require an active support contract. To find more information about support access levels, go to the following 
URL: 

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to the following URL: 

http://www.managementsoftware.hp.com/passport-registration.html

To view release notes and other documentation go to the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 
download Adobe Acrobat Reader, go to the following URL: 

http://www.adobe.com 
Or you can use the copy of Adobe Acrobat Reader provided on the OVIS Windows CD.

 

Legal Notices
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Copyright © 1996-2007 Certicom Corp. All rights reserved. 
This software contains trade secrets, confidential information, and other intellectual property of Certicom 
Corp. and its licensors. This software cannot be used, reproduced, or distributed in whole or in part by any 
means without the explicit prior consent of Certicom Corp. Such consent must arise from a separate license 
agreement from Certicom or its licensees, as appropriate. This software implements Canadian, U.S., and other 
nations' patents, both registered and pending (see the readme file included in this distribution). 
Warning: U.S. Federal and state laws and international treaties provide severe civil and criminal penalties for 
the unauthorized reproduction in any form of these copyrighted materials. Criminal copyright infringement 
constitutes a felony and is punishable by a $250,000 fine and up to 5 years in prison. 
Certicom, Certicom Security Architecture, Certicom Trust Infrastructure, Certicom CodeSign, Certicom 
KeyInject, Security Builder, Security Builder API, Security Builder MCE, Security Builder BSP, Security Builder 
Crypto, Security Builder ETS, Security Builder GSE, Security Builder IPSec, Security Builder NSE, Security 
Builder PKI and Security Builder SSL are trademarks or registered trademarks of Certicom Corp. All other 
companies and products listed herein are trademarks or registered trademarks of their respective holders. 
Certicom Corporation has intellectual property rights relating to technology embodied in the product that is 
described in this document. In particular, and without limitation, these intellectual property rights may include 
one or more of the U.S. and non-U.S. patents listed at www.certicom.com/patents and one or more additional 
patents or pending patent applications in the U.S. and in other countries. Information subject to change. 
This documentation contains proprietary information of Certicom and distribution is limited to authorized 
licensees of Certicom. Any unauthorized reproduction or distribution of this document is strictly prohibited. 
This product includes a copy of the Microsoft Data Engine (MSDE), redistributed under the terms of Microsoft's 
End-User License Agreement. 

Additional licenses can be found under <install dir>\license-agreements.
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open-source Notices

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.
openssl.org/). 
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). 
This product includes software written by Tim Hudson (tjh@cryptsoft.com). 
Additional open-source licenses can be found under <install dir>\license-agreements.

OpenLDAP Public License

The OpenLDAP Public License, Version 2.3, 28 July 2000 
 
Redistribution and use of this software and associated documentation ("Software"), with or without 
modification, are permitted provided that the following conditions are met: 
 
1. Redistributions of source code must retain copyright statements and notices. 
 
2. Redistributions in binary form must reproduce applicable copyright statements and notices, this list of 
conditions, and the following disclaimer in the documentation and/or other materials provided with the 
distribution. 
 
3. Redistributions must contain a verbatim copy of this document. 
 
4. The name "OpenLDAP" must not be used to endorse or promote products derived from this Software 
without prior written permission of the OpenLDAP Foundation. 
 
5. Products derived from this Software may not be called "OpenLDAP" nor may "OpenLDAP" appear in their 
names without prior written permission of the OpenLDAP Foundation. 
 
6. Due credit should be given to the OpenLDAP Project ( http://www.openldap.org/). 
 
7. The OpenLDAP Foundation may revise this license from time to time.  
Each revision is distinguished by a version number. You may use the Software under terms of this license 
revision or under the terms of any subsequent revision of the license. 
 
THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS ``AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
OPENLDAP FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT 
OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
OpenLDAP is a trademark of the OpenLDAP Foundation. 
 
Copyright 1999-2000 The OpenLDAP Foundation, Redwood City, California, USA. All Rights Reserved. 
Permission to copy and distributed verbatim copies of this document is granted.  
 
NetBSD C Library Source

Copyright (C) 1996-2002 Internet Software Consortium. 
 
Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby 
granted, provided that the above copyright notice and this permission notice appear in all copies. 
 
THE SOFTWARE IS PROVIDED "AS IS" AND INTERNET SOFTWARE CONSORTIUM DISCLAIMS ALL 
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WARRANTIES WITH REGARD TO THIS SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL INTERNET SOFTWARE CONSORTIUM BE LIABLE FOR 
ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER 
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE 
OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF 
THIS SOFTWARE. 
 
$Id: COPYRIGHT,v 1.6.2.2 2002/02/12 06:05:48 marka Exp $ 
 
Portions Copyright (C) 1996-2001 Nominum, Inc. 
 
Permission to use, copy, modify, and distribute this software for any purpose with or without fee is hereby 
granted, provided that the above copyright notice and this permission notice appear in all copies. 
 
THE SOFTWARE IS PROVIDED "AS IS" AND NOMINUM DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS 
SOFTWARE INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL 
NOMINUM BE LIABLE FOR ANY SPECIAL, DIRECT, INDIRECT, OR CONSEQUENTIAL DAMAGES OR ANY 
DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF 
CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE 
USE OR PERFORMANCE OF THIS SOFTWARE. 
 

 

©Copyright 2000 - 2007 Hewlett-Packard Development Company, L.P. 
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